# Table of Contents

TABLE OF CONTENTS 1

PART I – GENERAL INFORMATION 1

Introduction 1

PART II – THE CAMPUS NETWORK 2

Logging In 2

Changing Your System Password 3

How to shut down your computer 4

Wireless Access Using Personal Computer 5

PART III – HELP IS AVAILABLE 5

How to learn basic computer literacy 5

How to contact the IT department’s Help Desk 5

How to use the Help function on your computer 5

PART IV - MICROSOFT OFFICE 2007 SUITE 6

PART V - EMAIL 7

Accessing Email from Other Computers 7
- How to read your college email from home 7
- Log off when you have completed accessing your college email from home 7
- How to read your college email from other computers at the college 7

Email Spam 7
- How to use Outlook to send email to students 8

Managing Your Email 8
- How to use your Inbox effectively 8
- How to create folders for saved messages 8
- How to AutoArchive your mail 9
- How to set an Out of Office Reply 9

Other Outlook Features 10
- How to use the Outlook Calendar 10
- How to schedule meetings using Outlook Calendar 10
How to share files using Outlook Calendar

Outlook 2003 Web access
  How students get their email accounts
  How students access email
  How students send email to faculty and staff members
  How to encourage constructive, educational email
  How to discourage useless, trivial email

PART VI: EXPLORING THE WORLD WIDE WEB WITH INTERNET EXPLORER

How to open Internet Explorer
How to find a Web Page
How to use a search engine
How to start a list of favorite sites
How to organize your list of favorite sites
How to change your home page on your office machine
How to get help with MS Internet Explorer
How to backup your favorites

PART VII: BLACKBOARD LEARNING MANAGEMENT SYSTEM

Instructor Quick Start
Login
Changing Your Password, Email, and Other Information
Send Email
Add an Announcement
Add Item
Create a Discussion Forum
Add a Thread within a Discussion Forum
Enroll/Remove Student from course
Manage Groups

PART VIII: PRINTING

Printers and Printing Guidance
  Purchasing Printers
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print Volume Control</td>
<td>21</td>
</tr>
<tr>
<td>How to print</td>
<td>22</td>
</tr>
<tr>
<td>How to trouble-shoot printing problems</td>
<td>23</td>
</tr>
<tr>
<td>How to use a different printer</td>
<td>24</td>
</tr>
<tr>
<td>How to help students with printing</td>
<td>24</td>
</tr>
<tr>
<td><strong>PART IX: FILE MANAGEMENT</strong></td>
<td>25</td>
</tr>
<tr>
<td>How to understand good file management</td>
<td>25</td>
</tr>
<tr>
<td>How to organize files and folders</td>
<td>25</td>
</tr>
<tr>
<td>How to create folders to organize your files</td>
<td>25</td>
</tr>
<tr>
<td>How to organize your files</td>
<td>26</td>
</tr>
<tr>
<td>Disk Drives and Saving Files</td>
<td>26</td>
</tr>
<tr>
<td>How to find files</td>
<td>28</td>
</tr>
<tr>
<td>How to use shared directories</td>
<td>28</td>
</tr>
<tr>
<td>How to use the Common directory</td>
<td>28</td>
</tr>
<tr>
<td>How to use personal directories</td>
<td>28</td>
</tr>
<tr>
<td>How to get assistance using the network drives</td>
<td>29</td>
</tr>
<tr>
<td><strong>PART X: GETTING HELP</strong></td>
<td>30</td>
</tr>
<tr>
<td>Help Desk</td>
<td>30</td>
</tr>
<tr>
<td>Instructional Technology Center</td>
<td>30</td>
</tr>
<tr>
<td><strong>PART XI – CLASSROOM INSTRUCTIONAL TECHNOLOGY</strong></td>
<td>31</td>
</tr>
<tr>
<td>Presentation Rooms</td>
<td>31</td>
</tr>
<tr>
<td>Smart Classrooms</td>
<td>31</td>
</tr>
<tr>
<td>How to use the Presentation and Smart Technology Classrooms</td>
<td>31</td>
</tr>
<tr>
<td>Operating Requests</td>
<td>32</td>
</tr>
<tr>
<td><strong>Additional Special Purpose Labs and General Use Computer Areas</strong></td>
<td>32</td>
</tr>
<tr>
<td>Lyndon P. Lorusso Applied Technology Center, Room 116 – Open Computer Lab</td>
<td>32</td>
</tr>
<tr>
<td>Lyndon P. Lorusso Applied Technology Center, Room G02 – Writing Resource Center</td>
<td>33</td>
</tr>
<tr>
<td>Science 112 – Math Lab</td>
<td>33</td>
</tr>
<tr>
<td>Lyndon P. Lorusso Applied Technology Center, Room 104 – Computer Hardware Lab</td>
<td>33</td>
</tr>
<tr>
<td>Library Reference Area</td>
<td>33</td>
</tr>
<tr>
<td>Lower Library Lobby</td>
<td>33</td>
</tr>
<tr>
<td>North – Nursing Lab</td>
<td>33</td>
</tr>
<tr>
<td>Future – North Nursing and Science 104 and 105 renovations.</td>
<td>33</td>
</tr>
<tr>
<td><strong>Vision Equipped Computer Lab Classrooms</strong></td>
<td>34</td>
</tr>
<tr>
<td>Media Services</td>
<td>34</td>
</tr>
</tbody>
</table>
How to get audio-visual materials 34
How to get audio-visual equipment 34
Mobile Media Carts (MMC) 34

PART XII - PHONE AND VOICE MAIL SYSTEM USE AND INSTRUCTIONS 35
MAKING A CALL 35
CALL PICKUP FOR ANOTHER PHONE 35
CALL HOLD 35
CALL TRANSFER 35
CHANGE RING TONE 36
ACTIVATE YOUR VOICE MAIL BOX 36
RETRIEVE MESSAGES FROM YOUR PHONE 36
RETRIEVE MESSAGES FROM ANOTHER PHONE 36
RETRIEVE MESSAGES FROM HOME 36
TO CHANGE YOUR GREETING, NAME, OR PASSCODE 36
MESSAGE CONTROL 37
GIVE MESSAGE 37
DISTRIBUTION LIST 37
SENDING MESSAGE TO A DISTRIBUTION LIST 37

APPENDIX A - LAB & HELPDESK HOURS AND CALENDAR - 1 -

Academic Year 2007-2008 Holidays - 1 -

APPENDIX B - INFORMATION TECHNOLOGY RESOURCE USE POLICY - 1 -
General Principles - 1 -
Specific Principles - 1 -
  User Responsibilities - 1 -
  Acceptable Use - 1 -
  Unacceptable Use - 2 -
  Data Ownership and Confidentiality - 2 -
  Copyright Protection - 2 -
  Malicious Code - 3 -
  Network Security - 3 -
  E-Mail - 3 -
  Internet Use - 3 -
  Violations - 4 -
  No Expectation of Privacy - 4 -
  No Warranties - 4 -
Part I – General Information

INTRODUCTION

Cape Cod Community College has a state of the art technology infrastructure. Nearly nine hundred Dell computers are located throughout the campus to support the educational process. Computers are leased to ensure frequent renewal of equipment. The campus network infrastructure was upgraded in 2006 with the latest and fastest fiber optic technology and CISCO routing and switching to ensure the highest possible performance. Internet access speeds were increased significantly in 2007, nearly quadrupling available bandwidth. Planning for further bandwidth increases is underway.

Security upgrades will continue in 2007-2008 to increase the protection data and the confidentiality of information. Access controls and encryption systems are being installed to make sure those who access the college network are authorized to do so and the communications they send are protected from hacker intrusions. Complex passwords and other requirements were implemented in 2007.

Wireless access to the Internet is available throughout the campus. Personal wireless laptops are able to use the wireless network to access the Internet. By the fall of 2008 a security system will be in place that will require personal laptop users to log into the college network via the wireless network. When they login their computer will be assessed for proper anti-virus, anti-spyware, and operating system updates. If the laptop is not properly configured the user will be directed to remediation sites to correct the issue before accessing the college wireless network. This action will protect all users of the network from malicious code on any private computers accessing the wireless network.

The College provides network data storage for all users, email accounts, online registration and bill-pay, and access to a variety of other resources to assist users in attaining their educational objectives.

If you have a question or need help with any technology related issue begin by contacting the Help Desk. The Help Desk is located in Room 116 of the Lyndon P. Lorusso Applied Technology Center (Tech Building) or you can reach them by calling extension 4004 or sending an email to helpdesk@capecod.edu.
Part II – The Campus Network

LOGGING IN

Before a user can take advantage of the many IT resources available, he or she must log into the campus network.

When a user sits down at any of the campus computers, the screen will display a box like the one below (if the screen is black, press the space bar to wake up the computer).

As instructed, press <Ctrl>+<Alt>+<Delete>.

The Login screen will appear. It will have input boxes for a username and a password. You may also see a third box labeled Domain.

If you have recently joined the faculty/staff, your username is the first initial of your first name and your complete last name. Your initial password is Capecod1. The Computer will then prompt you to change the password upon initial logon. If you have been here for a while, your username is usually your first initial and the first seven characters of your last name. If you do not know your password, contact the Help Desk at extension 4004.

After entering your user name and password, you can either use the mouse to click on the “OK” button in the screen or simply press the <Enter> key on the keyboard. After a few minutes, the computer should display your
desktop, which is the standard arrangement of icons, each of which represents a different application. You can begin using an application by double clicking on the icon.

**CHANGING YOUR SYSTEM PASSWORD**

The new faculty default password is *Capecod1*. Because this information is somewhat public it is important to change your password to keep other people from accessing your email and files. If you are logging on to the system for the first time, you will be prompted to change your password as soon as you log in and will not be able to proceed until you make that change.

You may change your system password at any time. All user-level passwords are forced to be changed at least once each year. This is a minimum requirement. Users are encouraged to change their passwords more frequently. You should always change your password if you suspect somebody else may have gained access to your account.

All user accounts at Cape Cod Community College must meet the following level of password complexity:

All passwords must be at least 8 characters in length.
Passwords must not have been used in 4 previous passwords.
Passwords must not contain the individual’s name or account name.
Passwords must contain at least 3 of the following 4 character groups:

- English uppercase characters (A through Z)
- English lowercase characters (a through z)
- Numerals (0 through 9)
- Non-alphabetic characters (such as !, $, #, %)

General Password Construction Guidelines

Poor, weak passwords have the following characteristics:

- The password contains less than eight characters
- The password is a word found in a dictionary (English or foreign)
- The password is a common usage word such as:
  - Names of family, pets, friends, co-workers, fantasy characters, etc.
  - The user's ID, or subset thereof.
  - Computer terms and names, commands, sites, companies, hardware, software.
  - Word or number patterns like aaabbb, qwerty, zyxwvuts, 123321, etc.
  - Any of the above spelled backwards.
  - Any of the above preceded or followed by a digit (e.g., secret1, 1secret)

Strong passwords have the following characteristics:

- Contain both upper and lower case characters (e.g., a-z, A-Z)
- Have digits and punctuation characters as well as letters e.g., 0-9, !@#$%^&*()_+\`~\-\=\\\{\}\|;':",<,>,?/
- Are at least eight alphanumeric characters long.
- Are not a word in any language, slang, dialect, jargon, etc.
- Are not based on personal information, names of family, etc.
- Here is a list of "don'ts":
  - Don't reveal a password over the phone to ANYONE
  - Don't reveal a password in an email message
Don’t talk about a password in front of others  
Don’t hint at the format of a password (e.g., "my family name")  
Don’t reveal a password on questionnaires or security forms  
Don’t share a password with family members  
Don’t reveal a password to co-workers while on vacation

Do not use the "Remember Password" feature of applications (e.g., Eudora, Outlook, Netscape Messenger).

Passwords should not be written down or stored on-line. If one feels the password must be written down it should be placed in a location not associated with the computer such as a purse or wallet and the paper on which it is written should not be associated with the college or also contain the user login ID. When the password is fully memorized the paper should be destroyed.

Press <Ctrl>+<Alt>+<Delete> to bring up the Windows Security Screen and select Change Password, which is the button on the bottom left hand side of the box to bring up the Change Password dialog box. Note, if this is your first time logging onto Windows, you will not have to perform this step, as the Change Password dialog box will appear automatically.

The dialog box will display your username in the User name field and “CCCC” in the Log on to field. In the Old password field, delete anything that may appear in the box (there will likely be a series of asterisks) and type your old password. When typing, you will not see the actual characters you type, but will see asterisks for each keystroke.

In the New Password box, type your new password. When typing, you will not see the actual characters you typed, but will see asterisks for each keystroke.

In the Confirm New Password box, re-type your password exactly as you typed it in the previous box. When typing, you will not see the actual characters you typed, but will see asterisks for each keystroke. If the passwords you typed in the New Password and Confirm New Password fields do not match exactly, you will be prompted to start the process over again.

Click OK. If you were successful, you will receive notification that your password has been changed.

If you forget your system password, go to the Help Desk in Open Lab, Room 116, Lyndon P. Lorusso Applied Technology Center. Although they are not able to look up forgotten passwords, they do have the ability to reset passwords. They will reset your password to Capecod1 and you will be forced to change your password to something new during your next logon.

HOW TO SHUT DOWN YOUR COMPUTER

When you are finished working on your computer, you should shut down any programs you are using, being sure to save any unsaved information. Most application programs display three small squares in the upper right hand corner of the screen. They show a minus sign, a single or double square and an X. Clicking on the X closes the program.

Using the mouse, bring your cursor to the Start button usually located at the bottom left of the screen on your taskbar. When you click on the Start button, the Start Menu appears, allowing you to select several choices, the last of which is Shut Down. When you click on Shut Down, the Shut Down Windows dialogue box appears with a drop down menu allowing several choices, one of which is Shut Down the Computer. If Shut Down is not visible, click on the down pointing arrow to the right of the box to drop down the complete menu. Click on Shut Down to make the selection and then click the OK button at the bottom of the screen or press <Enter>. This begins the process of shutting down the computer. Wait while the college network automatically saves any unsaved
information for you. Depending on how your machine is configured, you may either get a message that says it is OK to turn off your machine, in which case you can press the on/off button on both the CPU and monitor, or it may shut off automatically. If the CPU shuts off automatically, you can turn off your monitor with the on/off button or allow it to go into sleep/energy saver mode. You have now successfully shut down your computer.

**WIRELESS ACCESS USING PERSONAL COMPUTER**

If you have a wireless network card in your laptop you can configure it for access to the campus wireless network. In your configuration tab you should be able to see and connect to the broadcast SSID named cccc as an available network. You should be able to connect to this SSID without any extra configuration steps. Once connected to the cccc SSID you will be able to browse the Internet, as well as connect to our internal Blackboard / Distance Learning web page. If you experience any problems please contact the the Help Desk at xt 4004.

**Part III – Help is Available**

**HOW TO LEARN BASIC COMPUTER LITERACY**

These instructions presume a limited degree of computer literacy. You should be familiar with using a mouse and a keyboard to operate a personal computer. If you have never used a computer, contact the Help Desk (extension 4004) and request advice on where to obtain basic computer instruction.

The Workforce Education Resource Center offers non-credit introductory courses for novice computer users at the Hyannis Center. The Information Technology program also offers for-credit courses in computer use.

Advice and assistance is also available from the Instructional Technology Center in the library at extension 4858 or by email at itc@capecod.edu.

**HOW TO CONTACT THE IT DEPARTMENT’S HELP DESK**

Office of Information Technology operates a Help Desk at extension 4004. You can submit a request for help by calling that extension, by sending an email message to helpdesk@capecod.edu, or visiting the Help Desk in the Open Computer Lab, Room 116, Lyndon P. Lorusso Applied Technology Center.

**HOW TO USE THE HELP FUNCTION ON YOUR COMPUTER**

The Help function is a great tool for learning how to do things in Windows or Office. If you are using Microsoft Windows or a Microsoft application program, the Menu Bar at the top of your screen includes words, such as *File, Edit, View*, etc. The last one is usually *Help*. Clicking Help will drop down a Help menu.
If you are in a Windows XP Pro window such as My Computer, click Help, and then Help and Support Center. A self explanatory screen will come up (right) that will offer a variety of Help options.

If you are in a Microsoft application, such as Word, Excel, or Powerpoint use the drop down Help Menu Bar at the top of the application screen to obtain Help. When you select a help function the appropriate Help information.

Most programs have a Help option. Using the Help option can often give you the answer you need immediately. Call the Help Desk at 4004 for more information on using the Help function.

**Part IV - Microsoft Office 2007 Suite**

The Microsoft Office 2007 Suite began implementation in the summer of 2007 and will be completed in the summer of 2008. The Suite consists of Word, Excel, Powerpoint, Access, Outlook, Publisher, and InfoPath. Those familiar with the Office 2003 will find there are significant changes in appearance, but word processing is still word processing.

All users are encouraged to learn about the changes in Office 2007 at the Microsoft Office Assistance Center at the following Uniform Resource Locator (URL): http://office.microsoft.com/assistance/

In particular, users are encouraged to view the Demo series “Up to Speed With (Word, Excel, Powerpoint)” that can be found here for each of the Suite applications. They are very informative and a good place to get a sense for the differences between Office 2003 and Office 2007.
In addition to the online help, the best place to start is the Help menu selection at the top of each application. By clicking on Help you will gain access to a large database of information, instruction, assistance, training, template downloads, and support communities. We encourage you to use this resource.

For more information, call the Help Desk at extension 4004 or for more extensive help, call and make an appointment with the Instructional Technology Center at extension 4858.

**Part V - EMAIL**

The College uses Microsoft Exchange Mail and the MS Office Outlook client for email. There is a wide array of functionality in Outlook for email, calendars, and contacts. You are encouraged to examine tutorials and the application and online help that is available with the program.

**ACCESSING EMAIL FROM OTHER COMPUTERS**

**How to read your college email from home**

It is easy to access your email from home, or any other off-campus location.

First, get access to the Internet by launching any Web browser software, such as Netscape Navigator or Microsoft Internet Explorer. In the URL address line, type in the following URL, noting that it does not begin with www. This is the complete address: http://mail.capecod.edu

When you have entered the URL and pressed enter, a Microsoft Enter Network Password box opens asking for your user name and password. In the username text box, type cccc\your user name(cccc\jsmith), which is the same as the first part of your email address before the ‘@’ symbol. Next, type your college password. Now press the enter key or click the **OK** button. This will bring up the web client, Outlook Web Access, which looks slightly different from the regular Microsoft Outlook window.

You will be able to read, reply, delete, send new messages, and have access to your contact list.

**Log off when you have completed accessing your college email from home**

When you have completed using your college email be sure to click the **Log Off** icon in the shortcuts menu. This brings you to a Microsoft Outlook Log Off box and asks you to click **CLOSE** to complete the Log off.

**How to read your college email from other computers at the college**

The same technique outlined above can be used from any computer in the world that has access to the Internet. This includes other computers on campus.

However, when using other computers on the campus network, you can also log onto the campus network using your own user name and password and access your Outlook email just as you would from your own office computer.

**EMAIL SPAM**
You may start to receive unwanted junk mail, which is known as “Spam.” These messages are often advertisements for adult-oriented web sites, various get-rich-quick schemes, and other products and services for which you have no interest. The senders of these emails often go to great lengths to hide their identities, so the return address that appears on the message is seldom a legitimate email address.

These emails often contain a paragraph at the bottom of the email inviting you to click on a specific link to remove your name from their mailing lists. YOU SHOULD NEVER CLICK ON THESE LINKS! In most cases, the only thing that you accomplish by clicking on that link is to confirm to the sender that yours is an actual, functioning email address. This invites more spam, not less.

Cape Cod Community College uses several techniques to combat SPAM. Presently, we use McAfee SPAMShield and Quarantine Manager to help combat spam. These tools are very effective in addressing the SPAM issue, but the College receives approximately 3 million emails each year and over 2 million are SPAM.

The Office of Information Technology makes every attempt to stop SPAM from going to your inbox and false positives incorrectly identifying a legitimate e-mail as SPAM; however, this is a balancing act and a constant battle goes on with no end in sight. Expect the occasional SPAM email to make it into your email box. If you notice it as a trend or feel overwhelmed by it please contact the HelpDesk at 4004.

How to use Outlook to send email to students

All CCCC students have a college email address, which will consist of the student’s username (first initial, complete last name and student ID number) @capecod.edu. As an example, J. Smith’s email address would be jsmith123456@capecod.edu. The email address for all students in a class will be included in class lists, which will be available through Jenzabar.

To send email to a student, users will have to look up his or her email address and type it carefully in the To field. Faculty members can create distribution lists for all the students in a given class, if desired. See How to create a distribution list.

MANAGING YOUR EMAIL

How to use your Inbox effectively

Every time you check your Inbox, it is a good idea to clear all the messages out of it, so that any messages in the Inbox are new. If you have dozens of messages in your Inbox, it becomes very difficult to deal with them. First, delete any messages you will not need again.

If you need to save a message, it is a good idea to move it to a folder you create for storing messages sorted by topic. That will make it easier to find a message later. If they are all in one folder, you may have too many to search through.

Your email box does have a maximum storage capacity of 60 Megabytes. Once you reach the maximum, you will not be able to receive or send any emails. We suggest you periodically clear out your Sent folder. If there are items you wish to save, move them to another folder and delete the rest. Keep in mind that all messages you store, including those in new folders you create, and even those in your Deleted Items folder, count against your quota until you delete them, and empty the folder.

How to create folders for saved messages
It is easy to create new folders on the server for storing email messages you want to save for later reference. With the main Outlook window on your screen, click on File ➔ New in the Menu Bar. Then click on the option File Folder below New. This will open a Create New Folder window, which asks you to type in the name of your new folder. Choose a name that makes sense to you for later reference. When you press <enter> that new folder will appear in your folders list. Note: To view a list of folders on the left of your screen, it is a good idea to activate the View Folder List option under the View menu item on the top toolbar.

If the new folder is not in the location you want, you can click and drag it to a location you prefer. If you drag it into a folder, the new one will appear as a subfolder of the original folder.

**How to AutoArchive your mail**

Because your email box has a maximum storage capacity of 60 Megabytes, and you will not be able to receive or send email when you reach that quota, you should autoarchive your email. This is an automatic process that moves emails from your mail box to another location, thus reducing the active mail being charged to your quota. The mail you archive remains fully accessible, it is just stored in your user directory on the Y drive where there is much more storage capacity. By autoarchiving you also improve the performance of Outlook on your computer.

### How to Turn On the AutoArchive Feature

1. On the Tools menu, click Options, and then click the Other tab.
2. Click AutoArchive.
3. Click to select the Run AutoArchive every check box, and then specify how frequently the AutoArchive process will run by typing a number in the days box.
4. If you want to be notified before the items are archived, click to select the Prompt Before AutoArchive check box.
5. In the Default archive file box, type a file name for the archived items to be transferred to, or click Browse to select from a list.
6. Click OK two times.

Now that you have turned on the AutoArchive feature, you must set the AutoArchive properties for each folder.

### How to Set the AutoArchive Properties for a Folder

1. In the Folder List, right-click the folder that you want to AutoArchive, and then click Properties.
2. Click the AutoArchive tab.
3. To set the AutoArchive properties for this folder, click to select Clean out items older than.
4. To specify when the items must be automatically transferred to your archive file, type a number in the Months box.
5. To specify a file for the archived items to be transferred to, click Move old items to.
6. In the Move old items to box, type a file name for the archived items, or click Browse to select from a list, and then click OK.
If you are going to be on vacation or otherwise unable to answer your email for an extended period of time, Outlook has a feature that allows you to send an automatic message replying to any incoming email messages to let the sender know you cannot respond personally at that time.

To do this, open the Outlook program and Tools → Out of Office Assistant. This opens the Out of Office Assistant box (right).

Click the radio button next to the words I am currently out of the office. Then, in the Auto Reply box, type any desired message. For example, it might say I will be out of the office from January 1 through January 15 and will not be checking my email during that period. If you need immediate assistance, please contact … This reply will be sent to all incoming mail while you are away. When you are finished, click OK to save these settings.

When you return from your absence, remember to go back into the Out of Office Assistant and Click the I am currently in the office radio button to turn off the Assistant.

**OTHER OUTLOOK FEATURES**

**How to use the Outlook Calendar**

Microsoft Outlook includes a Calendar feature that allows you to keep track of upcoming appointments, meetings, events, or anything else you want to schedule. From the main Outlook screen, you can access the calendar by clicking on the calendar folder under the Folder List or the Calendar icon under Outlook Today, or selecting GO from the Menu Bar and selecting the Calendar option. From there, you can select any view that works for you, such as Day, Week, or Month.

**How to schedule meetings using Outlook Calendar**

Once you are in any Calendar view of Outlook, click on the date when you want to schedule the appointment. Then click on the New Appointment icon on the toolbar. This opens the appointment dialog box.

Click on the Subject box and type in a brief name for the appointment. Also fill in the Start Time and End Time boxes. If you like, you can fill in the location and enter any notes you like. If it is a recurring appointment, you can indicate that as well, and Outlook will schedule it every week, or month, or whenever you indicate. You can also ask Outlook to remind you about the appointment.

**How to share files using Outlook Calendar**

If a group of people on a network agree to use the Microsoft Outlook Calendar to schedule appointments, it is possible to use the program to avoid scheduling conflicts. When creating a new appointment, click on the Scheduling tab and enter the names of people you want to schedule the appointment for in the All Attendees column. They will receive a request to participate and respond with either an Accept or Reject message to you.

For more information on using the Outlook Calendar, contact the Instructional Technology Center by phone at extension 4858 or by email at itc@capecod.mass.edu.
You can also get assistance by clicking on the Help icon when in Outlook.

**OUTLOOK 2003 WEB ACCESS**

How students get their email accounts

At the beginning of each semester, all CCCC students are assigned an email account, through Microsoft Outlook. Their email addresses will be their username (first initial + last name + student ID number), followed by the ‘@’ symbol, followed by “capecod.edu” (i.e. jstudent123456@capecod.edu). A list of email addresses for all students in a class will be provided to class instructors on the class roster.

How students access email

Students will be given instructions telling them how to access their email that are the same as those for faculty members wishing to access their email from off-campus. Students can do this from the computers in any of the college’s computer labs, writing center, library, or any off-campus computer that has Internet access. Once connected to the Internet, students launch a Web browser, such as Netscape Navigator or Microsoft Internet Explorer, and go to Outlook by typing http://mail.capecod.edu. From there, students can log on and access any email sent to their CCCC account, including mail from instructors. Instructors should remind students to check this email account regularly, since faculty and other staff members may use this system to communicate with students.

The student email accounts may also be used to exchange email with other email accounts anywhere in the world

How students send email to faculty and staff members

Students will be told that all college faculty and staff members have email accounts and how the user names are determined. Used properly, this can be a useful and convenient means for additional student-faculty communication.

How to encourage constructive, educational email

Classroom instructors can encourage their students to use email for specific purposes, such as submitting proposed topics for projects or seeking academic assistance. Email can also be used for scheduling student-faculty appointments.

How to discourage useless, trivial email

Faculty members can set their own policies about the types of-mail messages they will and will not accept. A faculty or staff member can save a copy of a standard message telling the sender that the email was not appropriate. Sending inappropriate email messages can be considered the same as making inappropriate comments in class.
Part VI: Exploring the World Wide Web with Internet Explorer

**HOW TO OPEN INTERNET EXPLORER**

All the computers in the Cape Cod Community College network are capable of connecting to the Internet. To find Web pages and perform various tasks on the Internet a computer must also have a Web browser program, such as Microsoft Internet Explorer. The college IT department provides support for Internet Explorer, since it is integrated with the other Microsoft products used on campus.

To open Internet Explorer, simply double-click on the Internet Explorer Icon on your desktop, and the program will launch itself.

An alternate method is to click on the Start button located on the left of the taskbar normally on the bottom of your desktop to launch the Start Menu, click on Programs and then find Internet Explorer from the list of programs, and click on it.

**HOW TO FIND A WEB PAGE**

When Internet Explorer opens, most of the screen will be taken up with the contents of a Web page, but the first four lines belong to the program itself, and do not change as you move from page to page. The top line (Title bar) displays the title of the Web page displayed below. Just under that is the Menu Bar with familiar choices such as File, Edit, View, etc. Below that is a toolbar with icons designed to make it easy to navigate around the World Wide Web. And just below that is the Address bar, which includes a window indicating the URL, or Universal Resource Locator, of the Web site displayed below. By typing in a different URL and either pressing the <Enter> key or clicking on the Go button to the right of the address, you can go to any site on the World Wide Web.

All URLs begin with the following characters: http:// but it is not necessary to type those in, Internet Explorer will automatically supply them for you. Most Web sites also have the letters www but some do not.

In addition to a URL, Web sites also have an IP address, which is a long series of numbers, but those are rarely used to access Web sites.

By far the easiest ways to find Web pages are to find them by using a search engine or a list of Favorites.

**HOW TO USE A SEARCH ENGINE**

There are hundreds of search engines on the Internet, all designed to make it easier for people to find places on the Web. Most also contain advertising, which is how they are financed. One of the most popular search engine is Google, and its URL is www.google.com.
In a search engine like Google, you can use plain English to type in the title of a Web site, or some words that describe the site you want. The search engine will look for sites that match those characteristics and allow you to choose among the results.

For example, if you go to Google and type in the words: college and Cape Cod, it will provide results that include the College Web site, whose URL is www.capecod.mass.edu.

**How to start a list of favorite sites**

If you are exploring the World Wide Web and discover a page you may want to find again, it is a good idea to make it a Favorite. This is important because it is sometimes difficult to remember the exact URL of a page. If you mark it as a favorite, you can always delete it later, but if you do not, you may not be able to find it again.

To add a page to your list of favorites on your office machine, make sure the page is displayed on your screen, then go to your Menu Bar at the top of the page and click on the word *Favorites*. Then simply select *Add to Favorites* from the options listed. This will open a dialog box that will suggest a name that will appear on your list of favorites. You have the option of changing that name to something that will remind you of the site, if you like. Click on *OK* and the page will appear on your list of favorites, which you can access by clicking on the word *Favorites* in the Menu Bar.

(If you are using Netscape Navigator, instead of Internet Explorer, the term is Bookmarks, but they operate the same way.)

**How to organize your list of favorite sites**

Another option under Favorites is *Organize Favorites*. Clicking this option allows you to delete favorites, rename them or reorganize their order. You can also organize them into folders. When you have completed doing so, click on *Close* to confirm the changes and close the box.
HOW TO CHANGE YOUR HOME PAGE ON YOUR OFFICE MACHINE

When Internet Explorer opens, most of the screen will be taken up with the contents of whatever Web page you have selected as your home page, which, by default will be the Cape Cod Community College Web page.

You can select another page as your home page. There are several ways to do this, but it is easiest if you have the page you want for your home page on your screen. Go to the Menu Bar at the top of the page and select ToolsÆ Internet Options.

This will open the Internet Options Dialog Box, which has several tabs. Under the General tab, which should be displayed by default, the first section is labeled Home page. If you click on the button labeled Use Current, whatever page is on your screen will become your home page. Then click on OK to confirm that choice and close the box.

There are other ways to change your home page. For example, you can type in any URL you like in the Internet Options Dialog box. Some Web sites have a feature that allows you to click on a link that automatically changes your settings to make that page your home page.

HOW TO GET HELP WITH MS INTERNET EXPLORER

The best place to start is the Help menu selection at the top of the Internet Explorer window. By clicking on Help you will gain access to another drop down menu. The two most useful drop down items are Contents and Index and Online Support. If you click on Contents and Index a dialog box will appear that allows you to browse or search for the issue of concern.

By clicking on Online Support in the Help drop down menu you will gain access to a large database of information, instruction, assistance, training, template downloads, and support communities. An alternative path to Internet Explorer 6 targeted assistance can be accessed by entering the following web address in the Address line of Internet Explorer: http://support.microsoft.com/ie6 or http://support.microsoft.com/ie7 depending on the version of Internet Explorer you are using. We encourage you to use this resource.

For additional on campus assistance with Internet Explorer, contact the Instructional Technology Center by phone at extension 4858 or by email at itc@capecod.edu. The ITC staff can arrange an individual or group session.
HOW TO BACKUP YOUR FAVORITES

Frequent backup of your favorites will ensure they are not lost in the event your computer fails for some reason or is re-imaged by IT as part of an upgrade process. To backup your favorites do the following:

While in Internet Explorer click on the File menu at the top left of the screen. Click on Import Export and a dialog box will appear titled Import/Export Wizard. Click Export Favorites and export them to your user directory on the Y: drive.
Part VII: Blackboard Learning Management System

The College utilizes the Blackboard Course Management System to deliver web-based instruction to students enrolled in full online or blended courses. A Blackboard course website is provided to every instructor. Also every student has a Blackboard account. The Instructor Quick Start guide below will assist you in the use of Blackboard. For additional help please contact the Office of Teaching and Learning Technology for assistance with Blackboard, Distance Learning, access to Mass Colleges Online, television and media services. The Office of Teaching and Learning Technologies is located on the ground floor of the Wilkens Library, Room LGC13. You may email them at distlrng@capecod.edu or call extension 4040 for assistance.

INSTRUCTOR QUICK START

The steps to login to Blackboard and change your password are summarized below. Also summarized are the steps to perform the most common instructor tasks, namely, (1) sending email to students, (2) post class announcements, (3) post course documents, handouts, etc., (4) set up discussion forums/threads, (5) add or remove students to maintain class roster, and (6) group students in BB site into Sections. The instructions for these latter tasks assume the reader is starting from the course site.

LOGIN

Access the Internet with Internet Explorer or Netscape (if you have AOL, start AOL, then once you are online, open I/E or Netscape without closing AOL)

Enter the web address http://blackboard.capecod.edu in the browser (you can also enter through the CCCC web site by clicking on the Blackboard Icon)

Click the Login button

When the screen appears, enter your User Name (first initial+lastname). If your last name is greater than 13 letters, only the first 13 are used. Also, any hyphens, periods, apostrophes, or spaces should be omitted.

Enter your Password (initially this is “instructor” – all lower case).

Click the Login button

You will be taken to a My_CCCC page in Blackboard. This screen contains links to “Courses You Are Teaching (on right side of screen). Click the course you want.

CHANGING YOUR PASSWORD, EMAIL, AND OTHER INFORMATION

Access the My_CCCC page (see above)

Click on Personal Information (upper left corner)

Click on Edit Personal Information to Change your Email address, enter your preferred email address (it is best to use your CCCC email address – the default - to avoid potential problems with the security filters of various ISP providers), then click Submit and then OK on the subsequent confirmation screen.

Return to screen in “b” above, Click Change Password and follow instructions on the screen
Return to the screen in “b” and “c” investigate the other options on the page, e.g., **Set Privacy Options, Set CD drive**, etc. to see if there are any others you wish to change. However, we recommend that you keep the default Privacy Options)

**SEND EMAIL**

From any course screen, click on the **Communications** button
Click on **Send E-mail**
Select whom you wish to email. After selecting the appropriate group or individuals, fill in the text in the **Subject** and **Message** fields
If you wish to add attachments to the email, click the **Browse** button and locate the file you wish to attach
Click the **Submit** button and, upon confirmation, click **OK**

**ADD AN ANNOUNCEMENT**

Enter the **Control Panel**
Click on the **Announcements** item within the Course Tools section
On the action bar in the top part of the screen, click on the **Add Announcement** icon
Type in a short descriptive title in the **Subject Box** (this title will be displayed in the MyCCCC screen when the student enters BB)
Type the full message in the **Message Box**.
Select the appropriate timing options for showing the announcement
Scroll to the bottom of the screen and click the **Submit** button
You should receive a confirmation. Click **OK**
You can check the appearance of the announcement from the student’s view by click on the course in the top navigation bar.

**ADD ITEM**

The Add Item action is the primary way of adding content of various types to your course. Files can be uploaded in their native format, e.g., doc, ppt, pdf, gif, jpg, wav, avi, mov, etc. Consequently, the students must **have the appropriate software on their computers** (this is one of the reasons the pdf format is preferred) to view them.

Click the **Control Panel** item under the Course buttons on left side
In the Content Area of the Control Panel, click on the particular Content Area where you want to add the item (default areas are **Course Documents, Course Information, Assignments, External Web Sites**, etc.)
Click the **Add Item** icon
Choose a **Name** from the drop-down menu or **type your own Title in the Name field**. Keep the title brief.
Enter a brief description of the item in the **Text** field. This text will appear just below the Title in the student’s BB view. The Text box has many of the same editing tools available as WORD.
To the right of the **File to Attach** field, click the **Browse** button and select the file you want to upload by navigating to it (e.g., on your computer, one of the CCCC servers, etc.) and clicking **OK**
In the **Name of Link to File** field, enter the wording you wish to appear just below the title from Step 3 above. Usually, one uses the type of file, e.g., WORD, PDF, etc. as a description or something like “Click to View …”.

In most instances, the defaults are taken for the remaining selections.

Then, click **Submit** and upon the confirmation, click **OK**

To view what the student will see, click the specific menu button corresponding to the content area

**CREATE A DISCUSSION FORUM**

A discussion forum is most often used by instructors to promote organized asynchronous interactions between students – analogous to class discussions. Often, within a particular forum, an instructor will post one or more topics (or questions) for discussion. Students reply/comment on the topic/question or to replies of other students. A “thread” is composed of the original topic/question and all the associated replies and replies to the replies. Discussion forums are also useful for group project and communications within a group of students (see Manage Groups).

**Steps to Add a Discussion Forum**

From a course page, click the **Control Panel** item below the navigation buttons  
In the Course Tools section, click **Discussion Boards**  
In the bar at the top of the next screen, click the **Add Forum** icon  
Fill in a title for the forum in the **Title** field  
In the **Description** text box, fill in a general description for the forum. This description will appear just below the link to the forum  
Select the desired forum settings as noted below

- **Allow anonymous posts** – Yes if checked, No if cleared (usually set to no)  
- **Allow author to edit after posting** - Yes if checked, No if cleared (usually set to No)  
- **Allow author to remove own postings** - Yes if checked, No if cleared (usually set to No)  
- **Allow file attachments** - Yes if checked, No if cleared (usually set to Yes)  
- **Allow new threads** - Yes if checked, No if cleared (usually set to No to maintain structure to the discussion when there are many students). If a social forum is set up or if the discussion forum is being used for a group project, this option is usually set to Yes

Click **Submit**

**ADD A THREAD WITHIN A DISCUSSION FORUM**

A thread consists of a question (or topic for discussion) within a particular forum and all associated replies and replies to the replies. Most often the instructor begins such a thread by posting a topic or question for the forum.

**Steps to Add a Thread**

Click the **Control Panel** from any course page
Click the **Discussion Boards** from the Course Tools section

Click the **particular forum** where the thread is to be added

Click the **Add Thread** icon in the action bar at the top of the screen

In the **Subject** field, type the topic/question which appears as a link

In the **Message** box, type a fuller description of the topic or question and what you want the students to do. This description is what the student see upon clicking the link (created in step 5)

If you want the thread to be added anonymously, check the box below the Message box.

Click **Submit**

---

**ENROLL/REMOVE STUDENT FROM COURSE**

Students that have registered for an instructor’s course will be batch **added** to the appropriate BB Course Roster (up to the end of the Add/Drop period. We do not, however, have a means to remove students from a particular BB Course Site. Therefore, for convenience, the instructor should keep the class roster up-to-date by enrolling or removing students who add or drop the course. The following steps can be followed to add or drop a small number of students from a particular BB Course. Another procedure, “Recycle Course”, can be more convenient in removing all students from a prior semester. This “Recycle Course” is not described herein.

**Steps to drop a student from a BB Course**

Access the **Control Panel** from any course screen

Click the **Remove Users from course** link

**If you are dropping more than one student**, Click the **Search** button with nothing in the search field and you should obtain a list of all the students BB has enrolled in the BB course site. Click the **Remove** box next to the names of the student(s) to be dropped. Type in “**Yes**” in the field just above the Submit button. Then click the **Submit** button.

**If you are dropping only one student**, it is easier to type the student’s last name in the **Search field** and then click the **Search** button. The student’s name should appear. Click the **Remove** box next to the name of the student to be dropped. Type in “**Yes**” in the field just above the Submit button. Then click the **Submit** button.

**Steps to add a student to a BB Course**

Access the **Control Panel** from any course screen

Click the **Enroll User** link in the User Management portion of the Control Panel

Type the student’s last name in the **Search field** and then click the **Search** button. The student’s name should appear. If it does not, then contact the Office of Teaching and Learning Technologies (X-4040). Click the **Add** box next to the name of the student to be dropped. Then click the **Submit** button.
MANAGE GROUPS

The Manage Groups feature is used by instructors to separate students into sections or to form project teams. The instructor is able to give the group’s access to “private” discussion boards, email, Lightweight Chat) (synchronous chat), and file exchange capabilities.

**Steps to form group, set options, and add students to group**

Access the Control Panel from any course screen

Click the Manage Groups link in the User Management portion

Enter a name in the Group Name field (e.g., Section 2)

Enter a short description for the group in the Description text box

Select the group options which you want to grant the group (i.e., group discussion board, group Virtual Class, group file exchange, and group email and whether you want the group to be visible now

Click the Submit button and upon confirmation, click the OK button

Click the Modify button next to the group and you will have links to Add Users to Group, List Users in Group, Remove Users from Group, and modify the Group Properties (that you selected in #5).

In adding, removing, and listing students in a group, you will encounter a Search box which functions like that explained in Enroll/Remove a student
Part VIII: Printing

Printers and Printing Guidance

Printing by staff, faculty, and students at Cape Cod Community College (CCCC) represents a significant operational expenditure each year. Printing costs were reduced dramatically in 2006/2007 by implementing a quota control system for student printing and raising general awareness about the costs of printing. This document sets forth guidance for the procurement of printers and print volume control.

Purchasing Printers

The initial outlay for purchase of a printer may be low for an inkjet printer but the lifetime operating costs are high because of the costs of ink cartridges. Manufacturers keep the price of the inkjet printer low with the expectation of high returns on the sale of refill cartridges. If you were to buy the ink for your inkjet printer by the gallon the cost would be about $8000 per gallon.

Laser printers are more expensive to purchase, but the life expectancy of the laser printer is about twice that of the inkjet printer. This is determined by the duty cycle rating of the printer. As a result, the typical office user can expect that the higher initial outlay for the laser printer is actually the same as for the less expensive inkjet printer because the laser printer will last twice as long.

By far most printing at CCCC is black and white text. Therefore, printer purchases at CCCC will by default be made in favor of a black and white laser printer. There will be some offices that need color or multi-function capabilities (i.e. fax, copy, print). IT will assist those offices to determine the optimum solution for their needs.

For example, in some cases, it may be appropriate to purchase an inkjet printer. In others, there may be enough demand in one area to justify a shared network color laser printer to meet the needs of several offices.

Printers will be ordered by IT using the following guidelines:

Student Use Printers The IT Department purchases printers and supplies for student use printers (e.g. labs and library general purpose use areas).

Office Use Printers. Departments purchase printers and supplies for their use. In most cases, the department will ask IT to order the printer in order to facilitate delivery and setup, but the budget code will be the department’s. Supplies are purchased by the department.

Print Volume Control

Cape Cod Community College must promulgate policies regarding printing, educate the user base, and implement technical means to prevent excessive and unnecessary printing, and control costs.

Students, faculty, and staff have legitimate needs for printing, but before sending a job to a printer the user should ask three very simple questions:

1. Is this a copy job or a print job? If you are printing multiple copies of a document it is a copy job. If you are printing a single copy of a document it is a print job. It may be more convenient to print to a printer than to go to the copy center, but the cost is much higher. If you require 100 copies of a flyer or 20 copies of a 10 page document, it may be more cost-effective to print to the copy center.

2. Can it be scanned? If the document is already online, it may be more cost-effective to print from your computer instead of printing from a paper copy.

3. Use both sides of paper when printing. This reduces the amount of paper needed and lowers costs.
document for your students it is a copy job, not a print job. Go to the Copy Center near the cafeteria to have copies made.

2. **Do I really need to send this print job to a color printer?** Printing to a color laser printer is more expensive than printing to a black and white printer. Only send a job to a color printer when it is absolutely necessary and you are printing a final copy, not a draft. Students require color printing for some graphics and other classes, but they should print drafts in black and white, and final copies in color for submission of a project.

3. **Is a larger, more efficient printer preferred for this job?** Larger printers print much more efficiently. If you have a large network printer or copier nearby your office set it as your default printer. Print to the smaller non-network printer on your desk only for specific purposes.

IT will place a placard on all network printers under its control to remind users to use the Copy Center for copying. All departments are encouraged to do the same.

<table>
<thead>
<tr>
<th>This printer should not be used for copying!</th>
</tr>
</thead>
<tbody>
<tr>
<td>If you require multiple copies of a document</td>
</tr>
<tr>
<td>please use the Copy Center.</td>
</tr>
</tbody>
</table>

IT has installed Print Manager Plus to track printing to all network printers on campus. Statistics are gathered each semester and a report produced for review of printing patterns and costs.

Students are assigned a quota of 150 pages per semester. Last semester, with no controls, nearly 95% of students printed less than 150 pages. Students who exceed the 150 pages must go to the Business Office to pay a $10 fee for an additional 150 pages for the current semester. The Business Office will provide the student a receipt and the student will bring that receipt to the HelpDesk where an additional 150 copies will be added to the student’s quota.

IT will set the default for all network printers to economy or fast draft mode. Users will have to initiate settings changes if they require higher than 300dpi printing.

All staff with a non-network printer in their office must set their printer to default to economy mode or fast draft mode. Assistance can be provided by the Help Desk if needed.

Printers with duplex (two sided) capability (normally larger printers and networked copiers) will be set to default to two sided printing by IT.

Users are encouraged to take other measures to reduce printing costs. For example, if printing a large document the printing preferences can be changed to print two pages on each side of the paper for a total of four pages on one sheet. It this technique is used in conjunction with the others above the savings could be 65% per job.

**HOW TO PRINT**

From almost any open window, printing a hard copy is virtually the same. Once you have the email message, Word document, or any other file open, follow these steps to print a hard copy to one of the many shared printers on campus.
Click the Print icon on the toolbar, select File→Print, or hold down the <Ctrl> key and press the <P> key. This will produce the Print dialog box, where you can select the number of pages and the number of copies to be printed.

To print all pages, select the default radio button All:. To print the page your cursor is on select Current page.. To select only the pages you wish to print select Pages:, then type the page numbers. The notation can be 1, 4, 10 or 6-8, 11, to include only the pages you wish printed.

If you want to print more than one copy at a time, click the up or down arrows to the right of Number of copies: until the correct numbers are visible in the text box. You can also highlight the number currently in the box and type the new number. Below this box is the word Collate. If you have multiple copies and wish them printed in numeric page order as opposed to all copies of page one, then all copies of page two, click to put a check mark in the collage box.

Once you have made these choices, click the OK button in the lower right corner of the Print dialogue box. This will produce a printed copy in the printer to which your computer is connected.

**HOW TO TROUBLE-SHOOT PRINTING PROBLEMS**

If you have trouble printing a document, follow these directions:

Call up the Print dialog box by choosing File→Print. Make sure there is a printer selected and that the number of pages and number of copies are what you want. You can also click on the word Help in the Menu Bar or press the <F1> key for help troubleshooting printer problems.

Physically go to the printer location and check to see that it is turned on, is getting power, and has paper. If these things are fine on the printer go back to your computer. Click the Start button, to bring up the Start Menu. (below left) Click Settings→Printers to bring up the Printers dialogue box.

Double-click your printer. Usually this will be the default printer and will be designated by a checkmark.

Look at the printer box to see if there are items listed. Is the name of your document in the list? Are other jobs in front of yours? If there are other jobs, are they in the process of printing or has printing stopped or paused? If, after checking all of these things, you cannot resolve the problem, contact the Help Desk by phone at extension 4004 or by email at helpdesk@capecod.edu. If you need more explanation or instruction about printing, contact the Instructional Technology Center by phone at extension 4858 or by email at itc@capecod.edu.
HOW TO USE A DIFFERENT PRINTER

If your computer has been set up with the option of using more than one printer, you may choose which printer to use. To do this, call up the Print dialog box by Choosing Print… from the File menu or pressing <Ctrl> <P>. To the right of Name: is a text box that should hold the name of your default printer.

To select another printer, do the following: Click the down-pointing arrow to the right of the named printer to drop down the printer name menu. Click to select another printer in the menu. Once selected you can make your choices as to number of pages and number of copies. Click the OK button to send your document to the newly selected printer.

If the printer you need to use is not listed, call the Help Desk at extension 4004.

HOW TO HELP STUDENTS WITH PRINTING

Printing in the open labs and classrooms is exactly the same as printing from your office if you print to a network printer. Our academic machines have the choice of the black and white laser printers and the color printer. We ask that both printers be used for necessary academic assignments and not for personal use. If you assign work that needs the color printer, have the student proof read on screen first, print to the black and white laser second to insure the look is correct, and then print final copies to the color laser. If you have an assignment that requires multiple copies, ask the student to print one original and take their items to the copy center for duplication. Always remind students to review their work on the screen, run spell check, and view Print Preview before printing. This will cut down on unwanted copies and save paper and toner. To help students print a document, follow the instructions How to print and How to use a different printer.
Part IX: File Management

HOW TO UNDERSTAND GOOD FILE MANAGEMENT

It helps to think of your computer as a file cabinet. Most people would not take an important document, open a drawer of a file cabinet, and just throw it in randomly. A computer is no different. With some thought you can create folders and subfolders to hold all of your documents in an organized manner and then move your current documents into the correct folders, making it much easier to locate documents later.

HOW TO ORGANIZE FILES AND FOLDERS

**This is very important** — you are discouraged from saving any material directly to the local computer hard drive. Always save your work, whether documents, spreadsheets or any other type to your personal user directory on the Y:/ drive.

The College keeps computers up to date with the latest software and operating system fixes using a technology called Disk Imaging. If your computer needs an update or it has somehow become corrupted the IT staff will “re-image” your computer. This process results in the complete deletion of every file on your local computer hard drive with no opportunity for recovery.

In addition, in all general purpose areas used by students the College uses Deep Freeze to prevent any inappropriate or malicious code from being introduced to our computers. Every time a computer is restarted in these areas every file on it is deleted and it is restored to a pristine condition.

There are many advantages to this approach. Users can access their files anywhere on campus. In the future, they will be able to access them from home. IT backs up all user directories as well so you never lose important materials.

HOW TO CREATE FOLDERS TO ORGANIZE YOUR FILES

The most important part of creating folders and subfolders is the thought you put into how you want them organized. One simple way is to create one main folder directly off the Y:\ drive, which is your personal, network drive space. It’s easy to find and everything is in a subfolder by topic under this file.

To create folders: Click the **Start** button and click My Computer see the listing of drives available to you. to launch Windows Explorer (see below).

To find your (Y) drive, scroll down until you see your username on FS1 (Y). Click to highlight it. You should now see all the contents of your (Y) drive in the right pane of the window.

With the (Y) drive in view on the right pane, click **File ➔ New ➔ Folder.** A New Folder will open at the bottom of the list of (Y) drive directories. The words “New Folder” will be highlighted and you can simply type the name of the new folder to replace the words “New Folder.”

You have now created your main organizational folder on the (Y) drive. From here double-click to open that folder and create as many more subfolders as you’d like. **Note: a quick way to create a new subfolder is to right click on a**
white area in the right pane of the parent folder. This will bring up the quick menu and you can click New, and Folder to create a new folder within that folder.

If you would like to rename any of your folders, right click the folder and select Rename from the menu. This will highlight the current name and allow you to type over the old name.

How to organize your files

You may want to create folders for subject areas, courses or individual classes, so you can more easily find related files. You can move files into a new folder by clicking on them and dragging the files into the new folder. As long as you can see both the source and the destination folders in Windows Explorer, you can move files among the folders using the click-and-drag method.

A more reliable alternative is to copy and paste files. If you use the Copy command <Ctrl>+<C> and then Paste <Ctrl>+<V>, the file will remain in both folders. If you use the Cut command <Ctrl>+<X> and Paste <Ctrl>+<V>, the file will only appear in the location into which you paste it.

It is helpful if you periodically delete any files you no longer need, so they do not clutter up your computer or the network.

Disk Drives and Saving Files

There are several ways to save files in the Windows operating system and several places to save files within the college network. The same principles that apply to the Word program also can be used to save files in any of the Office suite of programs.

You can only save changes to a document if it has a name. New documents are given a generic name such as Document1 or Document2, or the first words typed on the document. To give such a document a unique name, you can go to File on the Menu Bar and select the Save As… option. This will open the Save As dialog box.

Near the bottom of that box is a space to write in a name for the file. Near the top of the box is a space labeled Save in: This is a place to indicate in which folder you want the new document filed. You can select a different folder by clicking on the down-pointing arrow to the right of the Save in: text box and opening the drop down menu. Click to find the folder in which you want to save the file.

Near the bottom of the box is a text box with the words File name: to the left. This is where you type a name for the file. If the name in the box is highlighted, press the <delete> key to remove the current default name and type a meaningful name for your new document. If the current name is not highlighted, click four times in the box to highlight the text and then press the <delete> key. If you have previously named the document and you want to keep the name, leave this as it is.

Under the Windows operating system, files are saved in a series of folders and sub-folders. You can explore these folders by clicking on the My Computer icon on your desktop.

When you click on My Computer, you will see a series of drive types, followed by their designated drive letter in parentheses. The different types of drives and their uses are as follows.

3 ½ Floppy (A:) – This drive represents the floppy drive, which is located on the front of the computer. Students can save files to a floppy disk, then remove that disk and take it when they go. Blank floppy disks can store 1.44 MB of information and may be purchased at the campus bookstore. Floppy disks are inexpensive but should be used with caution, as they are prone to failure. When disks fail, it is often not possible to recover information
stored on them, meaning that information is lost. Files stored on floppy disks should always be backed up to some other location to prevent loss.

Local Disk (C:) – Almost all modern computers are equipped with a large-capacity, permanent drive called a hard drive. This is where the computer’s operating system and application programs are stored. While this is a common storage location for files on many home computers, students should NOT store any files here. All of the public computers on the Cape Cod Community College campus are equipped with special software that deletes new files from the hard drive each time the computer is restarted. Once files are deleted by this software, they cannot be recovered.

Compact Disc (D:) – computers all have DVD-CDRW drives. The ‘RW’ stands for “re-writable.” These “cd burners,” as they are called, use a special type of CD to permit users to create their own CD with their own files. There are also portable USB CD-RW drives available at the Help Desk that can be borrowed with a valid CCCC ID to be used with any of the other computers in the lab. Discs may be purchased from the campus bookstore.

The computer monitors are equipped with USB ports that will accommodate flash sticks for saving data. Flash sticks are available for purchase in the campus bookstore.

Network drives – Each user will see three network drives. These drives behave very much like a local hard drive, but do not reside on an individual workstation. Instead, these virtual drives reside on servers elsewhere on campus and will be accessible by the user, regardless of what on-campus computer he/she is using (network drives are not accessible from off-campus computers). The servers on which these virtual disks reside are backed up every night to prevent data loss.

Each user will have three network drives:

<username> on ‘FS1’ (Y:) – This is personal drive space. The user that owns the account is the only one who can save files to this drive, erase files, or even see what files are there. This space is designed for users to keep files they are working on so that they do not have to rely on unreliable floppy or zip disks.

faculty on ‘FS1’ (W:) – This drive may be used by faculty members to post assignments or other files needed for class. Students will be able to see all of the files on the drive and may open or copy them, but cannot create new files or delete those that are already there.

common on ‘FS1’ (X:) – This is common storage available to the entire 4Cs community. Any user logged into the network has permission to read, write, or delete from this drive. This is designed as temporary storage and any important data should not be stored here. All files on this drive are deleted each Friday.
How to find files

Windows includes a search tool to help you find files you may have trouble finding. If you click on the Start button at the bottom left of your screen, the Start Menu will appear, including the choice Search. Clicking on Search, will produce more choices, including For Files or Folders... If you select that option, it will open the Search Results dialog box.

You can either type in the name of the file in the first box or type in a line of text in the file you are seeking. Pay particular attention to the box labeled Look in and make sure it is searching the correct area, which is usually the (C) drive. The more you can limit your search, the less time it will take. The files the computer finds will be displayed in the right-hand window. You can open them by clicking on them there.

How to use shared directories

To save a file on the Faculty drive, which is designed for sharing files with students, simply use the Save As command. In the Save As dialog box, click on the One Level Up icon, which looks like a folder with an up arrow on it. Click the icon until you can see My Computer as a choice in the Save in: text box. Under My Computer you should have choices of several drives. Select the one that reads Faculty on ‘Fs2’ (W). If you have not already created a folder for your files on this drive, you can click on the New Folder icon, which looks like a folder with an asterisk on it. It will prompt you to type a name for the folder. Then click the Save button, and your file will be saved in that folder on the Faculty drive.

Creating a folder to save files on the Faculty drive is a good file management practice, but it is not required.

How to use the Common directory

To save a file on the Common drive, which is designed for sharing files with students, simply use the Save As command. In the Save As dialog box, click on the One Level Up icon, which looks like a folder with an up arrow on it. Click the icon until you can see My Computer as a choice in the Save in: text box. Under My Computer you should have choices of several drives. Select the one that reads Common on ‘Fs1’ (X). If you have not already created a folder for your files on this drive, you can click on the New Folder icon, which looks like a folder with an asterisk on it. It will prompt you to type a name for the folder. Then click the Save button, and your file will be saved in that folder on the Common drive.

We encourage you to create a folder on the Common drive to place your files in as it makes it much easier to direct students to the location.

Remember all files are deleted from this drive each Friday, so it should not be used for permanent storage. If you want to keep a file, save it on your personal Y drive or the Faculty drive (W).

How to use personal directories

To save a file in your own directory on the Personal drive (Y), which is accessible to you from any computer on the main campus network, but not currently from off-campus, simply use the Save As command. In the Save As dialog box, click on the One Level Up icon, which looks like a folder with an up arrow on it. Do this until you can see My Computer as a choice in the Save in: text box. Under My Computer you should have choices of several drives. Select the one that indicates your personal log-on and says on ‘Fs1’ (Y) Then click the Save button, and your file will be saved in that folder on your personal drive. You can create as many folders as you like on this drive.
How to get assistance using the network drives

For more information on using network drives, contact the Help Desk by phone at extension 4004 or by email at helpdesk@capecod.edu. You can also contact the Instructional Technology Center by phone at extension 4858 or by email at itc@capecod.edu.
Part X: Getting Help

HELP DESK

The Help Desk is the first place faculty, staff and students seek assistance with technology related issues. The Help Desk provides assistance with computers, software, printers, media requests, email, and many other technology related issues. If the Help Desk cannot solve your issue immediately they will know who can solve the issue and forward a request for action.

When you make a request of the Help Desk they will generate a Help Desk ticket if the issue cannot be resolved by immediate action. You will receive an email confirmation of the ticket generation. The ticket is then assigned by IT to the appropriate technician for action. The technician will likely contact you with questions and provide an email confirmation when the ticket is closed.

The Information Technology Help Desk is located in the Open Lab, Room 116, Lyndon P. Lorusso Applied Technology Center. They can be reached by calling extension 4004 or email helpdesk@capecod.edu.

INSTRUCTIONAL TECHNOLOGY CENTER

The Instructional Technology Center is a resource for faculty members. The Center assists faculty and staff in developing and integrating multi-media instruction, web-based resources and other forms of technology into courses, presentations and programs. Experts are available there to help instructors make use of technology for teaching. The assistance can take the form of a quick answer to a specific question, more extended instruction on how to use a program, or assistance with a specific project. A small computer lab and a variety of resource materials are available in the center. The center will be open from 9 a.m. until 1 p.m. Monday through Thursday during the semester. Additional times may be arranged by contacting the center.

The ITC is located on the 2nd floor of the Wilkens Library. Feel free to stop by during normal hours or call ahead to set up a personal appointment. You may call the ITC at extension 4858 or email them at itc@capecod.edu
Part XI – Classroom Instructional Technology

The College has made significant strides over the past year to increase the amount of technology in classrooms. A goal to move from an environment of limited numbers of mobile presentation carts to standardized fixed display capabilities in most rooms has been achieved. There are now 40 rooms with PRESENTATION or SMART technology fixed in the room. This number is believed adequate to ensure that any faculty member who wishes to teach in a modern room with presentation capability can.

The new Lyndon P. Lorusso Applied Technology Center provides a variety of computer lab resources. Each computer lab in the center has the latest computer technology. The building includes an Open Lab for student use, a small instructional lab for smaller groups, a high end CAD/GIS lab, a computer networking and breakdown lab, five standard computer labs, a writing lab, tutoring center, and conference room. Each of these rooms also has a Presentation capability.

PRESENTATION ROOMS

Presentation Rooms are rooms that have a built-in overhead LCD projector attached to a podium containing a computer with Internet access, a DVD player, VCR, laptop connection, and in some cases access to cable TV. Sound from the podium amplifier is played in the ceiling of the room.

Rooms with Presentation capability include South Building rooms G8, 105,108, 111, 115, 116, 117. North Building Presentation Rooms are rooms G5, G6, 104, 105, 114, 115, and 118. The Science Building are rooms 105, and 114. and the Lyndon P. Lorusso Applied Technology Center rooms are G02, 102, 103, 104, 114, 117, 202, 203, 204.

Some of these rooms have specific features of size or printing that make them more or less desirable for instructional purposes of one sort or another. Confer with the Facilities Use Coordinator to ensure you reserve the proper classroom at extension 4418.

SMART CLASSROOMS

SMART Classrooms are Presentation Rooms with an added feature – SMART Board Technology. SMART technology permits you to write on the computer screen with a stylus and project that writing onto the overhead screen. You can also save the image and use it for other purposes. South Building Room 114, North Building 117 and 116, Lorusso Building 101, and Lecture Halls A, B, and C have SMART Technology. In addition, all but South 114 have a Digital Presenter for projecting hard copy materials, transparencies, or small objects. Lecture Hall A has surround sound.

HOW TO USE THE PRESENTATION AND SMART TECHNOLOGY CLASSROOMS

If you have never used one of these rooms it is highly recommended that you contact the Help Desk and arrange a demonstration before you conduct your first class.

The Information Technology Help Desk is located in the Open Lab, Room 116, Lyndon P. Lorusso Applied Technology Center. They can be reached by calling extension 4004 or email helpdesk@capecod.edu.
Operating Requests

Keep chalk away from the podium. The dust is detrimental to the electronics and may cause permanent damage.

Do not use pens, pencils, or other objects on the podium screens. Use only the stylus supplied with (and attached to) the screens.

**ADDITIONAL SPECIAL PURPOSE LABS AND GENERAL USE COMPUTER AREAS**

The college maintains a number of computer labs for students to use to complete academic assignments and research. The computers in these labs are equipped with the Windows XP Professional operating system, the Microsoft Office 2007 suite, and many other popular applications. In addition to software, each lab has at least one laser printer, and high speed Internet access. A listing of the computer labs, their locations, and their hours follows:

**Lyndon P. Lorusso Applied Technology Center, Room 116 – Open Computer Lab**

This room contains 36 Dell desktop computers with 3 ½” floppy drives, DVD-CDRW drives, and flat screen monitors with USB plugs for flash sticks. Flash sticks can be purchased at the College bookstore. There are also three computers connected to scanners. Portable USB CD-RW drives are available to borrow from the Help Desk attendant. A valid CCCC ID must be left with the attendant when the drive is borrowed. These drives are only to be used in the Room 116 and are not to leave this room. Your college ID will be returned to you when you return the borrowed drive. This lab also has a color laser printer that can be used on a limited basis by students to print final versions of course related projects.

There is NO FOOD OR DRINK ALLOWED in any labs.

<table>
<thead>
<tr>
<th>Lab Hours</th>
<th>Monday – Thursday</th>
<th>7:30am – 9:30pm</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Friday</td>
<td>7:30am – 7:00pm</td>
</tr>
<tr>
<td></td>
<td>Saturday – Sunday</td>
<td>9:00am – 5:00pm</td>
</tr>
</tbody>
</table>

**Holiday closings for the 2007-2008 school year.**

<table>
<thead>
<tr>
<th>Date</th>
<th>Reason</th>
</tr>
</thead>
<tbody>
<tr>
<td>September 3, 2007</td>
<td>Closed Labor Day</td>
</tr>
<tr>
<td>October 8, 2007</td>
<td>Closed Columbus Day</td>
</tr>
<tr>
<td>November 12, 2007</td>
<td>Closed Veterans Day</td>
</tr>
<tr>
<td>November 22-23, 2007</td>
<td>Closed Thanksgiving</td>
</tr>
<tr>
<td>December 25, 2007</td>
<td>Closed Christmas</td>
</tr>
<tr>
<td>January 1, 2008</td>
<td>Closed New Year’s</td>
</tr>
<tr>
<td>January 21, 2008</td>
<td>Closed Martin Luther King Day</td>
</tr>
<tr>
<td>February 18, 2008</td>
<td>Closed President’s Day</td>
</tr>
<tr>
<td>March 17, 2008</td>
<td>Closed Evacuation Day</td>
</tr>
<tr>
<td>April 21, 2008</td>
<td>Closed Patriots Day</td>
</tr>
<tr>
<td>May 26, 2008</td>
<td>Closed Memorial Day</td>
</tr>
<tr>
<td>June 17, 2008</td>
<td>Closed Bunker Hill Day</td>
</tr>
</tbody>
</table>
Lyndon P. Lorusso Applied Technology Center, Room G02 – Writing Resource Center

This lab is staffed with personnel to help students with writing assignments of any type throughout the school year. The computers and software in this lab are identical to the computers in Open Lab, Room 116, Lyndon P. Lorusso Applied Technology Center.
Lab hours (begin in October and run through the end of classes)
Monday – Friday 8:00am – 3:00pm
Call extension 4526 for additional information, or check postings on the door.

Science 112 – Math Lab

This lab is staffed with personnel to help students with Math assignments. The room contains 5 computers with the same software packages as those found in Open Lab, Room 116, Lyndon P. Lorusso Applied Technology Center.
Lab hours are posted on door. Call extension 4626 for further information.

Lyndon P. Lorusso Applied Technology Center, Room 104 – Computer Hardware Lab

This lab is primarily for students taking computer hardware courses. The lab is equipped with Dells similar to those found in Open Lab, Room 116, Lyndon P. Lorusso Applied Technology Center, but are equipped with specialized hardware necessary for these particular classes.
Lab hours are posted on the door of the classroom.

Library Reference Area

The Library reference area contains 15 computers identical to those found in Open Lab, Room 116, Lyndon P. Lorusso Applied Technology Center, as well as a black and white laser printer.
This area is open during regular Library hours. Call extension 4342 for additional information.

Lower Library Lobby

There are 5 computers in carrels on the ground floor of the library. These computers are identical to those found in Open Lab, Room 116, Lyndon P. Lorusso Applied Technology Center.
This area is open during regular Library hours. Call extension 4342 for additional information.

North – Nursing Lab

This lab is equipped with 8 computers specifically set up for nursing students. In addition to the standard software packages found on the computers in Open Lab, Room 116, Lyndon P. Lorusso Applied Technology Center, these machines have additional software specifically geared to nursing students. Please call extension 4587 for lab hours, or check postings on the door.

Future – North Nursing and Science 104 and 105 renovations.

In the fall of 2006 the Nursing program will move to the North Building renovated Rooms G7, G8, G9, and G10. Approximately 20 student use computers for specific nursing programs will be located in the three classrooms. Each classroom will have a Presentation capability. There will also be an interactive video/audio capability for student evaluation using smart dummies. When the move is completed the previously occupied Science Building rooms 104 and 105 will be renovated with Presentation capability.
**VISION EQUIPPED COMPUTER LAB CLASSROOMS**

Instructors teaching in computer classrooms Technology 101, 102, 103, 104, 202, 203, and 204 will find interactive software called Vision that allows the instructor to interact with students through their computers. Vision has additionally been added to the Information Skills classroom in the Library, Hyannis D and Hyannis G to allow them the same interconnectivity.

Vision software allows instructors to watch, share or control the screen and keyboard of an individual computer or any group of computers in the classroom. Instructors can project their screen display on any or all of the computers in the classroom or project any student’s screen to the other screens in the classroom. The instructor can also monitor what is on any or all of the students’ screens. Instructors can transfer files among any of the computers in the classroom and use the network to hand out or collect files.

If you have never used Vision it is highly recommended that you contact the Help Desk and arrange a demonstration before you conduct your first class.

The Information Technology Help Desk is located in the Open Lab, Room 116, Lyndon P. Lorusso Applied Technology Center. They can be reached by calling extension 4004 or email helpdesk@capecod.edu.

---

**MEDIA SERVICES**

**How to get audio-visual materials**

Instructional Media Services, on the ground floor of the Wilkins Library LRC, consists of sound recordings, slide programs, films, and video recordings.

An index to the materials is available on-line through the college Web site www.capecod.edu. Most of this collection is non-circulating. Viewing and listening areas are available on a space-available basis. The Instructional Media staff will be happy to assist you in locating and using audio-visual materials. You can contact Instructional Media Services at extension 4444.

Classroom delivery of audio-visual material is the instructor’s responsibility. To reserve media, please call 4444 and arrange to pick it up prior to your class. The media should be returned by you when your class is completed.

**How to get audio-visual equipment**

To request audio-visual equipment for classroom use, please contact the Help Desk at extension 4004. **There is a 24 hour advanced notice required for all equipment delivery.** Equipment will be delivered to classrooms, but instructors must pick up the media (videotapes, recordings, etc.) themselves from the Instructional Media Services office on the ground floor of the library.

**Mobile Media Carts (MMC)**

The expansion of fixed display systems throughout the campus should reduce if not eliminate the need for Mobile Media Carts. MMCs are carts with projector, PC, and VCR/DVD. It is recommended your class be conducted in a room that has the appropriate technology rather than trying to move the technology you need to an inappropriate room.
To request a Mobile Media Cart contact the Help Desk at extension 4004.  *There is a 24 hour advanced notice required for all equipment delivery.*

To use the cart, ensure the power cord is plugged into the wall outlet. Check to see that the InFocus projector and the PC are turned on. Then plug the CAT5 cable with the RJ45 connector into the network port on the wall jack. (The RJ45 connector looks like a large telephone plug).

To use the computer on the cart, use the wireless keyboard and mouse to control the PC. Remember that the computers on these carts all have a program called Deep Freeze that will clean the system after every restart. If you load software, it will be deleted after the computer is shut down. If the software requires a restart to run properly, it will be removed before the restart completes.

To shut down the PC, first close down any application software you are running. Then click *Start* and then *Shut down*. In the next box, select *Shut Down* and *OK*. Finally, turn off the projector. Turning off the projector when finished will save wear and tear on the lamp.

To use the VCR on the cart, shift the projector from PC to VCR by pressing the “Video” button on the projector. Then insert a cassette into the VCR. Use the volume controls on the speakers that are on top of the cart to adjust sound.

**Part XII - Phone and Voice Mail System Use and Instructions**

**MAKING A CALL**
To make an on-campus call - dial the 4-digit extension directly
To make all off-campus calls - dial 9 then 1 then the area code and number
No calls are to be placed to classrooms.
Emergency calls for students are to be put through to Student Development (4320) where a determination will be made whether or not to disturb the student in class. DO **NOT** call the classroom!

**CALL PICKUP FOR ANOTHER PHONE**
To pick up a call ringing on another phone:
The phone is in your pickup group:
401 phones - press *6 on a 401 phone
410 & 420 phones - phones in your pickup group are programmed as buttons on the phone – just push the button of the phone that is ringing (an arrow indicates the ringing number)

The phone is NOT in your pickup group:
401 phones - press **6 and **dial the extension number of the phone you wish to pick up

**CALL HOLD**
To place a call on hold:
401 phones – press the flash key
410 & 420 phones - press the hold key
To retrieve a call on hold:
401 phones - press *7
410 & 420 phones - press key with flashing arrow
To retrieve a call on hold at another phone:
push # #7 - dial the extension number.

**CALL TRANSFER**
To transfer a call to another extension:
CHANGE RING TONE
To change the type of ring on your phone:
Lift Handset -- Press * 33 -- Press 33 again (phone will begin to ring) -- Press Volume tone
or ↓ key to select ring -- Hang up to keep selected ring tone.

ACTIVATE YOUR VOICE MAIL BOX
To set up your voice mail box for the first time:
Lift the handset -- Press 28 (if on campus) OR Dial 508-375-4050 (if setting up from home).
Wait for the recording -- Press * and your voice mail box number
When prompted for a pass code, enter your temporary pass code (which should be your extension #)
Follow the tutorial (call 4004 if you are told you have an invalid mailbox)
Remember your pass code.

RETRIEVE MESSAGES FROM YOUR PHONE
Lift the handset --
401 phones -- Press 22
410 & 420 phones -- Press VMAIL key
All three phones
Follow instructions on recording
Enter your pass code.

RETRIEVE MESSAGES FROM ANOTHER PHONE
When the phone extension number is different than your voice mail number such as adjunct faculty offices
Lift the handset -- Press 28 and wait for the recording -- Press * then your voice mail box number
Wait for the recording -- Enter the your pass code -- Follow the directions.

RETRIEVE MESSAGES FROM HOME
Call 375-4050 and wait for the recording -- Dial * then your voice mail box number
Wait for the recording -- Enter your pass code -- Follow the instruction -- Once connected
To PLAY messages press 7
To DELETE messages press 3
To KEEP messages press 5
To EXIT press 9

TO CHANGE YOUR GREETING, NAME, OR PASSCODE
Press 28 (if on campus) OR Dial 508-375-4050 (if calling from home)
Wait for the recording
Press * and your voice mail box number
Wait for the recording
Enter your pass code
Wait for the recording
Press 8 (for User Options)
Follow the instructions
Press 4 to change your greeting
Press 6 to change your name
Press 7 to change your pass code
Press 8 to follow the tutorial
MESSAGE CONTROL
To control voice mail messages while they are playing back:
Press 1 to pause (Press * to resume)
Press * to rewind 5 seconds
Press # to forward 5 seconds.

GIVE MESSAGE
To give a message to someone else after listening to it:
After listening, press 4
Dial a voice mail box number
Press # then record an additional message
Press # again after your additional message
Optional: Press 6 then 8 for urgent
press 6 then 2 for confidential
Press 9 to send message.

DISTRIBUTION LIST
To create or modify a distribution list for multiple voice mail boxes:
Press 28 and wait for the recording
Press *
Dial your voice mail box number and wait for the recording
Enter your pass code
Press 8 for user options
Press 5 for distribution list
Enter a list number (3 digit maximum)
Press 6 to record a name
press 9 to end recording
Press 2 to add numbers to list
Press 3 to delete numbers from list
Press 7 to listen to numbers in your list
Press 9 to exit.

SENDING MESSAGE TO A DISTRIBUTION LIST
To send a message to multiple voice mail boxes at the same time:
Press 28 and wait for the recording
Press *
Dial your voice mail box number and wait for the recording
Enter your pass code
Press 6 and Distribution List number
Press # and record your message
Press # after your message
Optional: Press 6 then 8 for urgent
Press 6 then 2 for confidential
Press 9 to send message.
Appendix A - Lab & Helpdesk Hours and Calendar

Lab & Help Desk Hours: (Check white board for changes)
Monday – Thursday  7:30AM – 9:30PM
Friday  7:30AM – 7:00PM
Saturday & Sunday  9:00AM – 5:00PM

<table>
<thead>
<tr>
<th>Academic Year 2007-2008 Holidays</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>September 3, 2007</td>
<td>Closed Labor Day</td>
</tr>
<tr>
<td>October 8, 2007</td>
<td>Closed Columbus Day</td>
</tr>
<tr>
<td>November 12, 2007</td>
<td>Closed Veterans Day</td>
</tr>
<tr>
<td>November 22-23, 2007</td>
<td>Closed Thanksgiving</td>
</tr>
<tr>
<td>December 25, 2007</td>
<td>Closed Christmas</td>
</tr>
<tr>
<td>January 1, 2008</td>
<td>Closed New Year's</td>
</tr>
<tr>
<td>January 21, 2008</td>
<td>Closed Martin Luther King Day</td>
</tr>
<tr>
<td>February 18, 2008</td>
<td>Closed President’s Day</td>
</tr>
<tr>
<td>March 17, 2008</td>
<td>Closed Evacuation Day</td>
</tr>
<tr>
<td>April 21, 2008</td>
<td>Closed Patriots Day</td>
</tr>
<tr>
<td>May 26, 2008</td>
<td>Closed Memorial Day</td>
</tr>
<tr>
<td>June 17, 2008</td>
<td>Closed Bunker Hill Day</td>
</tr>
</tbody>
</table>
Appendix B - Information Technology Resource Use Policy

General Principles

This document formalizes the policy for faculty, staff, students (both full and part-time) and all other individuals who have been granted use of the information technology resources of Cape Cod Community College (CCCC) (“Users”).

Information technology resources include, but are not limited to: computers, local and wide area networks, printers, other peripherals, software systems, data, electronic mail, and the Internet.

Access to CCCC’s computer systems and network imposes certain responsibilities and obligations as set forth in this document. Users are granted use of information technology resources subject to College policies, and local, state and federal laws.

Use of CCCC’s information technology resources shall constitute acceptance of the terms of this policy and any other applicable College policies, rules, and procedures.

Specific Principles

User Responsibilities

All information technology resources are owned and operated by Cape Cod Community College as an agency of the Commonwealth of Massachusetts. The College reserves all rights to these resources. It is the responsibility of any person using CCCC information technology resources to read, understand, and comply with this policy. Additionally, Users must comply with all other applicable College policies and procedures as well as state and federal laws. Any questions regarding this policy should be directed to the Vice President for Finance and Administration.

An account or user id is issued to faculty, staff and students when they begin their employment or studies with the College. An account or user id permits access to information technology resources. This account or user id is removed upon termination of one’s employment with the College or completion or withdrawal from an academic program.

Acceptable Use

The College’s information technology resources and services may be used only for academic, educational, or professional purposes which are directly related to official College business and in support of the College’s mission. The use of information technology resources is integral to enhancing productivity in the daily office routine and enabling faculty, staff, and students to make use of research and educational opportunities. Acceptable information technology uses may include but are not limited to:

- Using classroom and lab computers for class assignments
- Preparing instructional materials
- Publishing research
- Personal computing to improve computer literacy and to learn new software and/or hardware
- Accessing generally available individual and campus information
- Using the technology to support faculty and staff in performing their work
- Authorized and approved use of the College’s information and administrative systems
- Using the Internet to promote collegial and professional interaction, research, and productivity
**Unacceptable Use**

The following uses of CCCC information technology resources are unacceptable uses:

- Performing any illegal act, including violation of state and federal civil or criminal laws, and regulations
- Using these resources for any political purpose
- Conducting any commercial venture resulting in personal income or profit
- Using another person's user id or sharing your user id with another person
- Sending harassing or threatening messages
- Accessing, downloading, storing, or transmitting child pornographic materials or obscene materials
- Infringing on any intellectual property rights
- Gaining or attempting to gain unauthorized access to any computer or network
- Doing anything that causes interference with or disruption of network users and resources, including
  - propagation of computer viruses and any program that harms the operating environment
  - Intercepting communications intended for other persons
  - Misrepresenting either the College or a person's role at the College
  - Distributing chain letters
  - Accessing online games or gambling sites
  - Libeling or otherwise defaming any person

This list of unacceptable uses is not intended to be exhaustive.

**Data Ownership and Confidentiality**

Data and information stored in the College's computers and associated systems belong to the College, and its dissemination and use must comply with the College's policies and procedures. Users shall not access, release, use, or disseminate confidential or proprietary information unless User is authorized by CCCC to do so and such access, release, use, or dissemination is consistent with state and federal law.

**Copyright Protection**

Pursuant to the Digital Millenium Copyright Act, 17 U.S.C. Section 1203(i)(1)(A), any user of CCCC's technology resources who engages in copyright infringement shall have his/her access privileges terminated. Computer software is intellectual property. Software publishers and vendors can be very aggressive in protecting their property rights from infringement. These intellectual property rights extend to information published on the Internet, such as text and graphics.

Users who buy their own software agree to comply with any and all provisions of the software vendor in the software license agreement. Users are not permitted to copy software made available by the College to any other computer. In instances where a license agreement links a license number to specific computers by serial number, and the hardware is replaced or upgraded, the license agreement must be changed accordingly. In instances where the College holds a site license, Information Technology Services (ITS) holds the site license. Even though copying for College use is allowed for these types of agreements, it must be done in coordination with ITS.
All software on all computers on campus must be properly licensed. ITS maintains inventories of all computers and all software products installed on each computer. When users have made their own software purchases, it is their responsibility to furnish a license agreement when audited.

**Malicious Code**

Viruses, worms, Trojan horses, and other malicious code can be embedded in text files, executable files, graphics, word processing documents, spreadsheets, and e-mail messages. The College uses technical methods, such as anti-virus, anti-spyware, anti-SPAM software, to reduce the probability of a successful attack or infection. However, a holistic approach is the best defense against introduction of malicious code. Users should exercise reasonable precautions in order to prevent the introduction of harmful files. Users should not disable virus scanning utilities and should use such utilities to scan files downloaded from the Internet or obtained from a questionable source, and to scan portable media such as floppy disks, compact disks, and universal serial bus (USB) sticks.

**Network Security**

CCCC computers are connected to a local area network, which links computers through the College and through the wide area network to computers in other locations. All users should avoid compromising the security of the network. Users should **never** share their passwords with anyone else and should promptly notify ITS personnel if they suspect their passwords have been compromised.

Users who leave their computers unattended for extended periods should either log off the network or have password-protected screen savers enabled.

**E-Mail**

Microsoft Exchange Server with the Microsoft Outlook 2003 Client or Outlook WebAccess is the official College e-mail system.

Electronic Mail is a tool provided by the College to complement traditional methods of communications and to improve administrative and educational efficiency. All e-mail accounts and all data transmitted or stored using e-mail facilities are owned by the College.

Broadcast messages to all staff and faculty using the #CCCC Faculty/Staff email group should be used only for essential College announcements of concern to the entire College community.

All users should consider e-mail messages to be the equivalent of formal written communications and thus, should be professional and courteous in tone. Remember that an e-mail message can be stored, copied, printed, or forwarded by recipients. A general rule of thumb is not to put anything in an e-mail message that you would not write in a memorandum, nor be willing to post on a bulletin board or discuss in a public meeting.

Public Folders within Outlook are provided as a service for posting general news, events, and other College-related information. These folders will be monitored by those responsible for their content. Any posted material deemed inappropriate will be removed without prior notification. Public Folders are also subject to specific guidelines suitable for that particular folder.

**Internet Use**

The Internet is a useful tool for supporting many types of academic and business-related research. The College is committed to promoting responsible Internet access. All users should view Internet access as a privilege.
Users should be aware that many web sites gather and store information about visitors to their site. Care should be taken when registering for anything online, since this is analogous to giving your name, address, and phone number to a stranger.

Users must be aware of the potential for malicious code to be introduced onto the College network and computers by downloading and installing files from websites, even those that seem innocuous. Users should be extremely cautious when making decisions about downloading software from the Internet.

Users must be aware of the College's limited Internet bandwidth. In addition to adhering to the College's policy regarding acceptable and unacceptable uses, Users are discouraged from activities that consume large bandwidth, particularly during the peak daytime use periods. A single user can have a serious detrimental impact on all College Users by failing to follow this recommendation.

**Violations**

Failure to observe this policy may subject individuals to disciplinary action, including, but not limited to, loss of access rights, expulsion, termination of employment, and/or referrals to appropriate authorities in the event of violations of state or federal laws.

**No Expectation of Privacy**

CCCC information technology resources are the property of Cape Cod Community College and the Commonwealth of Massachusetts and are to be used in conformance with this policy. When reasonable and in pursuit of legitimate needs for supervision, control, and the efficient and proper operation of the workplace, CCCC will exercise the right to inspect any User's computer, any data contained in it, and any data sent or received by that computer. Use of CCCC information technology resources constitutes express consent for CCCC to monitor network activity in any form that CCCC sees fit to maintain the integrity of the network. Therefore, Users shall have no expectation of privacy over any communication, transmission or work performed using CCCC information technology resources.

**No Warranties**

CCCC makes no warranties of any kind, whether express or implied, for the service it is providing. CCCC will not be responsible for any damages a User suffers. This includes loss of data resulting from delays, no-deliveries, or service interruptions caused by CCCC negligence or by the User's errors or omissions. Use of any information obtained via the Internet is at the User's own risk. CCCC specifically denies any responsibility for the accuracy or quality of information obtained through its services. Users need to consider the source of any information they obtain and consider how valid that information may be. Additionally, CCCC is not responsible for lost or deleted documents, files, e-mails, and other electronic resources.

CCCC also specifically denies any responsibility for a User's encounter, access or use of any inappropriate or controversial materials from CCCC information technology resources, including the Internet. Users must notify the Executive Director of Information Technology if they identify information technology resources being used in a manner inconsistent with this Policy.